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The Vaki feeding system:  
 

Vaki feeding system is automatic feeding system designed for Fish Farms. The system utilizes one or 
more feed storage silos, which is useful when different sized feed is used. The main parts of the 
system are controlled augers, air lock, funnel, motor, blower, a rotary selector valve, and pipes. 
 
Feeding operation is based on feed from the storage silo the silo empties into a feed dosing auger. 
The auger moves this feed into a funnel which make sure that the feed goes to airlock and then into 
the main transport pipe. Air from an air blower blows into the distribution valve where it is directed 
into the individual feed pipes and transferred to specific tanks. 
 
The operation of the system is controlled by Programmable Logic Controller (PLC). Programmed 
computer software is used to interface and program the feeding system. The system software 
controls feeding operation such as feed rates, meal times, feed types, etc. The operator can monitor, 
interface, reprogram or override the automatic operation of the system.  
 
The feeding software application, VPS_Admin, can manage one or more Vaki feeding systems.  
 
The feeding systems are either set up for automatic or manual mode.  Hatcheries and smolt farms 
are set up in automatic mode.  System calculates the need for food based on biomass, temperature 
and other factors and feed them in small dozes distributed along most of the day.   For the large fish 
in the on sea cages the system is run in manual mode. An operator starts the feeding  and keeps it on 
until fish has had enough and stops eating. 
 
This manual is intended to give a good description of how the VPS_Admin application works, setup of 
the system and tech how to perform necessary tasks when working with a feeding system. 
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Overview 
Below is the main screen of the VPS_Admin. The large area on the left shows icons for all cages 
defined in the system.  In the upper right area are the silo icons, displaying proportional amount of 
food in each.  On the lower right we have the definition for the feeding system(s) controlled by this 
application.  In this case there is only one.  The details of the menu bar at top are described in 
specific section.   
 

 

Cages 
Colour of the cages: 

Green: cage is functional and has a population of fish defined. 
Grey: Usually means no population/empty cage or cage defined as a raceway. 
Yellow: Cage has been intentionally set inactive so it will not be fed during automatic 
feeding. 

 
The rectangle at bottom of each cage displays the name set on the population it contains.  As can be 
seen, the population names are not required to be unique.  Notice also that the colour of the border 
on the name tag is the same as on the system module icon in the lower right – which is clarifying 
when multiple systems are managed from application. 
 
Error and warning signs are displayed on the right on top of the population name tags.  Error signs 
are red and warnings are yellow (as on picture above). 
 
Cage popup window shows up when mouse is hovered over the cage icon and shows some basic 
statistics:  

Count: Number of fish in cage 
Avg (g): Average weight of fish 
Today kg: Feed into cage today (updated every hour) 
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Temperature: Registered temperature for cage 
 
When moving the mouse over the >>Warning<< field a description of the warning will pop up. <Edit> 
button brings up the population window (described later) and the <Chart> button show some 
historical data for this cage: 

 
 

Silos 
More detailed info about silo content can be accessed by hovering 
mouse over the silo icon: 

In Silo: Current amount of feed in silo (kg) 
Needed: How much feed you add to the silo so it will last the 
whole day.  The grey colour of the silo walls/background turn 
yellow when this amount is none-zero 
Usage: Estimated one day’s usage  

These information are updated on every hour when VPS_Admin 
automatically reads info from PLC machine. 
 
Click the <Add feed> to register more feed to silo – or correct its content 
 
 

System modules 
The system module icons show the status on the PLC machines.  
Green colour on the square on the left side tells us that the serial 
connection to the PLC is ON. Red square means no connection.        
The status strings at the bottom may be: 

Retrieving data… Reading feeding data from PLC and storing into database  
Writing to PLC  Writing feeding setup instruction to PLC  
No Connection ! Some problem in serial connection between pc machine and PLC 
Failure: Some internal failure in the PLC 
Automatic  System is idle in automatic mode 
Feeding… System is busy feeding in automatic mode 
Manual ready System at rest in manual mode 
Manual feeding…  Busy feeding in manual mode 

 
By clicking on the system module icon you bring up the control pages for that system. 
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Table view 
Clicking the bar at the top in the cage area toggles on the table view of the cages. 

 
In table view you get a brief overview of the statistic of all cages.   Click the bar at top (now marked 
‘Dashboard view’) to toggle on the cages view again. 
 

Populations, edit & setup 
Creating population, insert the populations name and description. In population sheet insert the 

Total amount of the fish and the gender of the fish.  The average fish weight must be entered as well 

as the total feed per day (the total feed can also by calculated (see button) based on the biomass in 

the cage and other factors ) 

Check the “Auto update” for automatic update on the average weight  and the daily feed amount.  

Those numbers are automatically updated once pr/24 hours.   For the automatic calculations to 

work, the fields: “SGR Id”, “FCR” and “Corr. factor” must be properly filled  Insert appropriate SGR-Id 

table, FCR and Correction factor and weighted average.  

Feeding info gives information of total feed into the cage today and yesterday.  
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Number of fish  

Total: The total number of fish in the cage. When the population is created the fish is added 
by adding fish number in the Total box.   When the total number of fish goes to zero, the 
current population is terminated. 

(…) To change the fish number or change the gender ratio in the population press the (…) 
button. Then following window appears. 

  

Add: Select type of adding or deleting fish from the cage. It is possible to choose from 
A (Add), H (harvest), M (Mortality).  

 

+: insert total amount of fish that should be added or deleted from the cage. Chose 
opposite sign if that is needed.  

Gender: If the gender is known select ether male or female otherwise select 
unknown.  
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Female: Total amount of female fish in the population.  

Male: Total amount of mail in the population.  

Unknown: Total amount of unknown fish in the population.  

 

Auto update: Select auto update to active the SGR field.  

SGR:  

SGR Id: The “SGR Id” is a name of a predefined Specific Growth Rate table, which is a table that 
specifies the growth rate based on temperature and the average fish weight in the cage. 
  

FCR is the Feed Conversion Ratio defined for the species in the cage.  

Corr factor is a way to increase or decrease the feed amount per day if we don’t like the amount 

calculated “by the book” by the application.  FCR=1 is neutral, but for example if FCR=1.1 the 

amount will be increased by 10% from the “theoretical “ amount calculated based on the SGR, 

FCR, biomass and temperature . 

Global Correction Factor is an option set from <Configurations> -> <Options> .  When that 

option is chosen, a small box will appear in the lower right corner on the cage area where you 

can set the correction factor for every cage in the system in one operation. 

Feeding info 

Yesterday:  Total kg fed Yesterday.  

Today: Total kg fed Today 

Average weight: Average weight (grams) Average weight is entered here. Also corrections in average 
weight are entered here. You can chose which unit to use here under <Configurations> -> <Options> 

Total Feed per day: Total amount of feed per day.  

Calc. Feeding: Calculate feeding. Press this button to if any changes as been made in the sheet.  

Active: To active feeding in the cage. Inactive when the population should be starving. Then the cage 
on the main screen appears to be yellow. 

Total biomass: Total fish biomass in the cage.  

 
 
 
To connect or change the feeding profile for the population, go to the profile sheet on the population 
window. And select the profile in the profile Id box or create a new profile for the population. 
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See how to edit the profiles at: Edit -> Feeding profiles pg.14 
 

Silo connection 
The silo for the population is chosen on the silo sheet in the population window select silo. The silos 

are listed down the column with description of feeding type. At least one silo must be selected for 

the population. 

 

 
 

Move population (whole or part) between cages 
We use mouse drag and drop. Let’s describe it by an example. 
We want to move 10000 fishes from cage C7 to the new C9 cage. 
We move the mouse to the name field at the top of C7s popup 
and put left mouse button down there – and then drag the 
mouse pointer to the C9 name. Mouse pointer should then 
change to a small square and the icon will jump – showing that 
the cage accepts a drop.  With the square mouse pointer on, you 
release the mouse button again and a dialog will be brought up.    
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You enter the number 10000 into the “Number of fish moved” field and press <OK>.  And you’re 
done. 
 
 

System modules control pages 
By clicking on the system module icons, you bring up their control  pages. 

  

Above we have a setup with 3 systems for doing manual feeding.  Control pages for systems 1 & 2 

are open.  The status strip at the bottom of each page shows status info retrieved from the PLC 

machine - from left: the clock, auger throughput, current encoder readout and the operation state. 

The temperature and pressure number are readouts from the optional sensors attached to the 

feeding system (see: Configuration -> Sensors pg.22) 

The manual feeding is controlled from the Manual feeding tab.    
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Other tabs are:   

Log:  Displays various messages from the system 

Setup: Setup communication port.  Here under is also the possible to test the 

revolver/encoder and the blower.   

Calibrate: Calibrate the silo/auger discharge throughput in terms of grams pr. Second 

FeedLog: Logging from the PLC of all recent feeding details in automatic mode 

 

Manual feeding  
Referring to the picture above with the manual feeding tabs open.  To start manual feeding is so 

simple as select the cage to feed into in the listbox control and press the <Start> button.  Augers 

throughput can be adjusted at any time with the throughput slider.  Amount fed to cage appears in 

kg in the big letters  at bottom of page.    

To stop feeding, simply press <Stop>. The auger will stop immediately, but we have to wait some 

defined blow-out time before we are ready to start feeding to another cage. 

Setup tab 
Here we enter the serial port number to connect to the PLC machine. 

  

Under the <Blower test> button we can run some tests on the blower and the revolver. Notice 

though that the state of the PLC must be “Manual ready” – otherwise access to blow test page isn’t 

allowed.  THe button will bring up the formBlow page on the right.   You can set the revolver to 

specific location.  In the listbox at the top all cages defined to this system are listed.  There are three 

“pieces” of information about each cage:   CageName_EncoderPosition_PipeNumber.  You select a 

cage and press the <Set> button and the revolver will move to correct position to blow into the 

selected cage. 

In the middle, you can enter any valid encoder position and press <Set> to get the revolver into that 

position. 

By the two buttons at the bottom of page you can turn the blower on and off. 

Calibrate tab 
The amount of food given is controlled by time adjustments.  We determine how much food we 
deliver from silo (by the augers in most cases) pr/time unit. The discharge speed of feed from the silo 
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may depend on the type of food and its character (dry/wet, sticky/loose..) and the amount in the silo 
(more feed in silo -> more pressure at bottom -> more discharge speed) 
In short, we do like that: Run the auger for a specific amount of time.  Collect the food coming from it 
and then put it on a scale and weight it.  Then we do the math: 
  (Amount in grams)/(Seconds auger running) = (calibrated grams pr/ second 
Then we enter the resulting grams pr. Second as the calibration value. 

 

We select the silo ID number in the dropdown box. 
Notice the <Run Test>.  You can click that button to run the auger for a specified amount of time – 
but only if the status strip at the bottom of the dialog shows: “Manual ready”; there is a button on 
the PLC’s el-cabinet which can be used to put the PLC into that state. 
After running the test and having the measurements, you enter the resulting value into the edit field 
and press Save.    
As you can see we keep track of older calibrations, but only the ones who are checked in the “Use” 
columns are used.  We can use multipoint calibration by selecting more than one set of calibrations.  
It can be good if we notice that there is some real difference on the discharge speed depending on 
the amount of food in the silo. In other words use calibration points with both low and high amount 
of food in silo.  There are actually how limits on how many points are used – the system will 
interpolate the used calibration value depending on the amount in silo at that time. 
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FeedLog tab 

 

Here you can see the last 100 feeding bursts from the PLC and check if they are in accordance with 

your intentions.  Each entry, from left: 

1. Time of feeding 

2. Pipe number 

3. Silo number 

4. Time duration of burst in seconds 

5. Cage name 

 

Menu system 
This chapter goes through the menubar from left to right: File, Edit, View, Action, Configuration 

 

File -> New -> Feed profile 

An option to create new feeding profile.  See profile edit section below for more details about 
profiles. 

File -> Exit 
Click on the exit to close the VPS program.  

Edit -> Feeding profiles 
The feeding profiles are presented as graphs. The feed intervals in the plan are an hour. The numbers 
from 1 to 23 are presented under each graph. The numbers at top are the percentage amount of the 
day’s feeding that will be done during that specific hour.   

The columns can be dragged up and down by the mouse. Curve shapes can be created by checking 
the Straight & Curved checkboxes.  
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Profile Id: Insert Profile name/Id for the profile.  

Description: More detailed description of the profile name.  

Start time/End time. Start time and end time of the feeding period. The profile feeding period is 
changed by choosing its time period or letting the percentages of inactive hours be 0%. 

Edit -> Directories 
Define directories for miscellaneous uses.  Se details in: System definition and application startup 

pg.27 

Edit -> Data base 
Database definition for system.  See details: System definition and application startup pg.27 

 

 

View -> PLC Time table 
PLC Time table shows total feed per hour in each cage over one day period. Two first columns on the 
left side show the pipes and the cage it is connected to. The third column shows total feeding time 
per cage. The feeding time results are shown as time in seconds.  The entries for hours 0 to 23 are 
values for a single feeding “shot” which needs to be multiplied by number of rounds pr/hour of 
encoder to get the totals 

The bottom line shows how much the feed load in % per hour. Total: feeding time +blowing time+ 
time to empty pipe.  

Notice that for cage C01, all times are zero because C01 has been set inactive as can been seen by its 
yellow colour 
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On certain occasions when the system is overloaded the load % at bottom might reach 100%. This 
means that Vaki VPS_admin will not manage to finish the feed circle over that period.  Possible 
corrections are: Reduce feeding by decreasing activity and appetite factors. Increase/adding periods 
in the feeding plan. Change the physical calibration on the augers by changing the gearing from the 
motor. 

 

View -> PLC Weight table: 
PLC weight table shows the total weight of feed per hour in each cage over one day period. Two first 

columns on the left side show the pipe and the cage it is connected to. The third column shows total 

feed per day. Columned named 1 to 23 shows the total feed (kg) per hour of the day in each cage. 

Total feed in each hour can be seen in the bottom line.  

 

 

View -> Refresh Cages/silos  F5 
Refresh changes that have been made on the program.  

 

Action -> Add Feed  
To add to or take feed from the silo, open the add feed into silo box, choose silo and Feed type then 
insert amount (“+” added “–“taken) 



Feeding software Manual 2021 

 

17 
 

 

Date: Select the date when feed was added to silo. It is not necessary to insert information´s about 
feed adding on same date as it was added.  

Silo: Select silo that the feed was added to.  

Feed: Select feed type. If the feed type is new and haven’t been used before go to chapter xxx.   

Kg: Amount of feed added to the silo. If some amount of feed is taken from the silo add (-) in front of 
the number. Then the feed is subtracted from the total amount.  

Add: Press the add button to make requested adding or subtracting changes. 

Close: To close the window, press the close button or the (x) in the upper right corner.  

Notice: You can also add feed to silo on the silo icon.  

 

Action -> Add Temperature 
Add new thermometer by pressing the “+” button Connect thermo to the cage by writing the 
thermometer name in the thermo description column. Write the temperature value in the 
temperature column. Remember to save the changes before closing the window.  
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Thermold: Thermometer number 

Themo description: Shows the thermometer name (description).  

Date: The date the thermometer ?? 

Temperature: Temperature measurements are added in this column. Click in the line for each 
thermometer to change the temperature.   

Manual:  Select manual when the temperature measurements are added manually.  

User Id:  

Save: save changes before the window is closed.  

Close: To close the window, press the close button or the (x) in the upper right corner. 

Notice: Thermometers can also be created automatically when a cage is created.  

 

Action -> Send to PLC 
Sends changed information to PLC.  System sends those settings automatically every two hours, but if 

you just made some changes on any feeding settings and you want them to become active 

immediately, you will use this option. 

Action -> Feed info from PLC 
Get feed info from PLC. 

System fetches automatically feeding info from the PLC once every hour.  Here is an option to force 

such fetch. 

Action -> Update biomass 
Update biomass. Notice that the biomass is automatically updated just after midnight every day. 
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Action -> Transfer files  

 

Here it is possible to manually print file(s) containing feeding info which are intended to be 

transported to other systems.  One file pr. each day is printed.  Format is according to the Norwegian 

NS 9403 standard.  Files will be printed to location as specified at: Edit->Directories  

 

 

Report -> Growth and feeding history 
Pick date range and run.  Columns to display in the table can be chosen under: Configuration -> Report 

pg. 21 

 

 

Configuration:  
Under this xx is it is possible to make configurations for the main parts of the system. Such as: farm 

information, population, feed types, SGR tables and Hardware. The hardware changes are divided in; 

encoder and pipes, cages, silo and thermometers.  

Configuration -> Farm 
The farm settings box shows information about the farm the name and location. Name, address, city, 
post code, country, comments.  

See more at: System definition and application startup, pg.27 
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Configuration -> Feed types 
Feed Id shows the id of the feed e.g. the description column gives information about the feed like the 

diameter.  + , and x are add and delete buttons.  

 

Feed Id: Feed Id here the feed Id is the mm of the feed size.  

Description: Description of the feed type, in this example it is also the mm of the feed that describes 

the feed.  

Configuration -> SGR Tables 
SGR growing table shows water temperature in cages versus  average fish weight in population.  One 
standard growth table is in Vaki VPN_admin “Vaxtartafla”. To suit other specifics like trout and 
halibut it is necessary to add new SGR table.  Other weight tables are more suited for these species 
and have other weight intervals. 
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It’s possible to use the included growth table or add new growth tables by clicking on “new” button. 
Add temp Add Weight buttons gives the table new column or line.   

SGR Id: is the name or Id for the SGR table.  

New button: is for adding new SGR table. Then the table Id is inserted and information’s filled in to 
the SGR table. 

SGR table:  °C\Gr. The first column in the SGR table shows the temperature in °C the first line shows 
the Gr.  

Add Temp: Add temperature line to the SGR table.   

Add weight: Add weight column to the SGR table.  

Refresh: Recalculates changes 

Save: Save the changes. It is Important to save changes before the window is closed.  

Close: close the From SGR window.  

 

Configuration -> Report 
Select which columns should be visible in the Feed Growth Report  

 

With column descriptions: 

Cage:  Shows the cage number/name.  

Pop (population): Shows the population Id.  

Description: Fish history/saga where is he coming from?  

Total fish beginning: Total amount of fish in the beginning of chosen time period.  

Total female beginning: Total amount of female in the beginning of chosen time period. 

Total male beginning: Total amount of male in the beginning of chosen time period. 

Total Created:  amount of populations started at the time period.  

Total Moved in/out of population: Total amount of fish moved from population.  

Total Mortality Female: Total mortality of female.  

Total Mortality Male: Total Mortality of Male.  

Total Mortality: Total mortality of female and male.  

Total Corrected:   Corrections of total amount of fish e.g. recounting unknown reason for changes.  

Total Harvested: Amount of harvested fish.  

Total Stripped:  Total amount of stripped fish.  

Total End: Total amount of fish in the end of chosen time period.  

Total Female End: Total amount of female in the end of chosen time period.  

Total Male End: Total amount of male in the end of chosen time period.  

Average weight Start (kg) in the beginning of period Biomass (kg): shows the biomass in the cage in kilos. Biomass is number of fish multiplied with average 
weight.  
Average weight End (kg) in the end of period 
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Total Biomass Beginning (kg):   

Total Biomass End (kg) 

Total Feeding (kg): Total amount of feeding during the chosen period. The next field is the “total feed so far” This field will show how many kilos are fed since 
the cage was started up. The actual calculated feed conversion factor will be presented. This factor is calculated from the number and weight of fish and the 
total feed amount from start up.  
Total Feeding pr. Fish: Total amount of feed for each fish.  

FCR: Current FCR. Feed used to product one Kg of fish.  

Calculated FCR. Feed conversion factor: The feed conversion factor is value representing the weight gain in the fish from one kilo of fish feed. If the fish is fed 
100 kg and the conversion factor is set to 1.2 the biomass should increase 100/1.2=83.33kg. 

 

Activity factor: Activity factor is a value t increase or decrease the feeding calculated by the growth table. The activity factors are multiplied with calculated 

amount of feed. For example if the software have calculated a feed demand od 100Kg but the activity factor are set to 805 the feed output will be 

100kg*805=89kf 

 

Configuration -> Dashboard layout 
A tool to move the cage icons around on the screen and adjust their dimension 

 

Configuration -> Sensors 
There are some feeding systems where it is important to 

monitor temperature and pressure of the air blown into the 

pipes.  These temp- and pressure sensor are connected to a 

dedicated PLC machine and here we can set up the Ethernet 

communication to it so values from sensors can be displayed 

on VPS_Admin main screen.    Here we also define wich values 

are acceptable and when to issue warning. 

Picture shows resulting readouts from a sensors on system 

under operation. 
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Configuration -> Options 

 

Here at top we can set preferred unit for the average fish weight.   

Click on the (i) to bring up further information on options. 

Global correction factor:  Global correction facto will affect all nonempty populations 
visible in the board, with <Auto update> set ON.  Every time the factor is activated 
or changed the correction factor of each of the populations will get the same value. 
If the global factor is active and the correction factor of a population is changed to 

a differerent value, that population will get a warning status. 

Use Hi-Res layout:  If content of some pop-up boxes and forms don't fit within it's 
boundaries, you should check this one.  You need to reboot application for changes to 

show. 

At the bottom you can hide unused profiles so they are not taking up space in the dropdownlists. 

 

Configuration -> Hardware 

Configuration -> Hardware -> Create Cages 

Create new cage definitions.  See description in the setup section: Create Cages, pg.33 

Configuration -> Hardware -> Silos 

Add silos to the system.  See description in the setup section: Define Silos, pg.29 

Configuration -> Hardware -> Thermometers 

Option to add thermometer definitions. 
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Configuration -> Hardware -> Encoder and pipes 

Pipes and encoder 

Settings for the encoder size and then connections between the encoder and pipes, where should 

the rotator valve stop to feed through correct pipe. When those connections are installed the Cages 

are connected to the pipes. 

 

The table connect the encoder to feeding pipes and the feeding pipes to cages.  

Number of the encoder stop is shown in the first column;  

Encoder value: The value where the encoder should stop to hit the holes.  

Pipe descriptions: Description of pipe if needed not necessary.   

Cage Id:  Appropriate cage   

Sec. to empty pipe is the time the blower is using to blow the feed through the feeding pipes.  

Round time is the time that the “rotator?” is going the 360°sircle. The accuracy is more when the 
round time is slower.  

Rounds per hour, is the feeding frequency in each cage for one hour. The more feeding frequency per 
hour the smaller the feedings are and vice versa.  
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Number of pipes is the possible pipe number on the changer.  

Encoder size offset helps to set the Encoder stops.  

Add: Recalculates all encoder offsets based on number of pipes and registered offset 

Reset:  Recalculates all encoder offsets based on number of pipes 

Slave 

This sheet is for slaves users.  

Cages 

This sheet shows if the pipe to silo is active or not.

 

Cage Id: This column shows the list of cages   

Active: The active column shows if pipe is connected and active from the feeding system to cage.  

Date Started: The column shows when pipe from the feeding system was connected to each cage.  

 

Configuration -> Hardware -> Edit Cages 

An option to modify some of the setting belonging to a selected cage 
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You select a specific silo by clicking its name (C7 here). 

Name: When a cage is created it will get a name which is the same as its ID number.  Its name can be 

modified but the ID number is unchangeable.   

Descr: Just an optional description for this cage. 

Thermometer setup can be changed and the temperature value of currently connected thermometer 

can be edited.   

Pipe(s) setup can be modified here.   

Raceway: Check to define this cage as raceway 

Delete:  You can delete a cage here if no population is attacked to it and no feeding information 

registered on it 
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Initial setup 
This section is a walk through of a typical setup of a Vaki feeding system.  Some of the chapters 

herein may also be usable when some modification need to be done on the system later is the 

systems lifetime. 

System definition and application startup 
We will show the initial setup here. Starting from a fresh database, containing no data. 
We are going to build a demo where the VPS_Admin will manage 2 feeding systems.  We will name 
these systems Vaki01 & Vaki02. The init file (admin.ini) shall by like this:  

 
 
 The VPS_Admin application comes in a zip file.  After extracting its content, just run the Setup.exe 
and the application should be ready. 
First time you run the application you may see some error messages.    Ignore them for now and just 
press the <OK> until you have the blank VPS_Admin screen in front of you.   

 
You need to set the correct path to the init file: admin.ini, described above under the Directories 
option: 

 
Log file path is also good to define, especially during the run up of the system.  Log files may 
become helpful to track down various kind of problems.  If log file path is left empty, nothing 
will be logged.   
The transfer file path is used if we are transferring feeding info to some external systems.  
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Files with feeding info will be written to that location – automatically by the end of the day if 
the checkbox below is checked. 

  
We also have to tell the application about how to access the database – under the Data Base option: 

 
Here we see an example of how a database setup might look like. (Notice the defaults though, in 
most cases they can be used).  In the greyed line below the input fields you see the current 
connection string the db connection. 
 
After verifying and saving init file and database setups, you need to restart VPS_Admin. 
When the application starts up and detects the empty database it will pop up a form where you have 
to define the farm: 

 
The FarmID is mandatory and you will not be able to change it again later!  You should also put some 
value in the Licence Code field.  Leaving it empty might cause problems later. 
 
When VPS_Admin comes up, it should look similar as this one: 
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Notice there are like 3 fields on the screen.  The one on the left will contain the cages, but the upper 
right will contain the silos, when defined.  The vertical and horizontal border lines can be dragged by 
the mouse to adjust the field sizes.  The changed border positions will be automatically saved. 
 
 

PLC/PC connection 
The PLCs are connected to PC via serial port.  In our example here we should have two serial ports to 
the PLCs.  Some of the PC computers used have serial ports, but in others we are using serial to USB 
adapters.  
If we are using the USB adapters, a comport number is automatically assigned to the port, and you 
need to enter this port number to setup the communication between VPS_Admin and the PLC.   In 
the Windows Device manager under Com ports you should be able to find the assigned Com port 
number(s).   
You have to click on the feeding system icon in the lower right quarter of screen to bring up the 
control page for that system.  Select the Setup-tab and enter the Com port number.  Save and try 
Reconnect.  If that’s not enough to get online with PLC – try to restart the VPS_Admin application. 
See also: Setup tab, pg.12  
 
 

Define Silos 
We want to define two silos for each system.   
To create the silos for Vaki01 we do the menu path: 

Configurations->Hardware->Silos->Vaki01 
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You create two silos by clicking the + (at the lower left) twice.  Enter the capacity of the silo (can be 
changed later) but just leave the other fields empty. 
 
We do the same for the second system:  

Configurations->Hardware->Silos->Vaki02 
 
Notice that the silos for the first system will get the id numbers 1&2, but for the second system it will 
be 11&12. 
 
Throughput:  
Controls the feed flow, the feed flow can be set on 25%, 50, 75% and 100%. 
 
If the factor is set to 25% the auger works in one sec and rest in three sec.   
If the factor is set to 50% the auger works in one sec and rest in one sec.   
If the factor is set to 75% The auger works in three sec and rest in one sec.   
If the factor is set to 100% the feeder will feed in one portion.    
 
 
 

Define feed types and add food to silos. 
Before registering feed into the silos we need to create the types of food we are going to use.  Se 
path: 

Configuration->Feed Types 
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Use the + sign to add food type.  Enter a descriptive Feed Id, but the description is optional. 
 
To add food to a given silo, just move the mouse over that given silo icon on the screen and press the 
<Add food> button.   There you select the food type and enter the amount of food which is being put 
into the silo: 

 
 
 

Calibrate Silos 
The amount of food given is controlled by time adjustments.  We determine how much food we 
deliver from silo (by the augers in most cases) pr/time unit.  
In short, we do like that: Run the auger for a specific amount of time.  Collect the food coming from it 
and then put it on a scale and weight it.  Then we do the math: 
  (Amount in grams)/(Seconds auger running) = (calibrated grams pr/ second 
Then we enter the resulting grams pr. Second as the calibration value. 
 
To calibrate Silo 1, which belongs to the Vaki01 feeding system, we have to click on the Vaki01 icon 
in the lower right corner to bring up its control window and there select the Calibration tab. 
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Notice we select the silo ID number in the dropdown box. 
Notice the <Run Test>.  You can click that button to run the auger for a specified amount of time – 
but only if the status strip at the bottom of the dialog shows: “Manual ready”; there is a button on 
the PLC’s el-cabinet which can be used to put the PLC into that state. 
After running the test and having the measurements, you enter the resulting value into the edit field 
(13.5 here) and press Save.   Repeat this for each silo.    
(If you are working in the setup phase of the system you can of course just but in some dummy 
numbers as calibration values and correct them later when feed has been put in the silos) 
See more about calibrations: Calibrate tab  pg.12 
 
 
 
 

Set encoder and number of pipes 
To change the encoder settings go to: 

   Configuration->Hardware->Encoder and pipes->VakiNN 

Set round time and rounds per hour and number of pipes, encoder size and offset.  This window is 

described in more details in chapter: Configuration -> Hardware -> Encoder and pipes, pg. 24 

 

Thermometers 
Although thermometers are listed here under hardware, the VPS_Admin doesn’t currently support 

automatic connection and reading of the real thermometer.  We depend on user registering the 

temperature for each defined thermometer when needed.  It is important to know the temperature 

in the cages to be able to estimate the growth of the fish living there. 

Many cages can share one thermometer – or one thermometer can be created for each cage. 
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There are two ways to create the thermometers: 

 Go to the thermometer page under:    Configuration->Hardware->Thermometers 

 Automatically create thermometer when the cages are created – such that each cage has its 

own thermometer (see Cage create section) 

 Register temperatures 

One way to register temperatures is to go to:  Actions->Add temperature 

Here you will get a list of all thermometers defined in the system and you can edit the temperature 

value for them. 

Another way is to use the Cage edit feature: Configuration->Hardware->Edit cages  

which will bring up the edit cage dialog her from you can select individual cages from the main 

screen and edit the temperature of the thermometer attacked to that given cage.  

 

Create Cages 
Create cages dialog (for Vaki01) at:  

Configuration->Hardware->Create cages->Vaki01 
 

 
Number of cages: You can create multiple cages in one operation 
ID prefix letter:  The ID/Name of the cages will become on the form 
C1, C2… 
Use shared Thermometer: If NOT checked, a separate thermometer 
will be created for each cage.  If checked, after creation of cage you’ll 
have to edit the cage settings and assign a thermometer to it. 
Auto connect to pipes:  Pipes and encoder must have been defined 
before to use this option. In this case the cages being created now will 
be assigned to pipes 1,2&3.   If you leave this option unchecked, you’ll have to assign pipes to cages 
later in the encoder & pipes page: Configuration->Hardware->Encoder and pipes  
Icon Dimension: The original dimension of cage icon will be according to this setting (in pixels). It can 
be modified later.  
 
When pressing the <OK> button, the cages are created and the 3 icons will appear stacked in the 
upper left corner of the screen.  The Dashboard layout dialog will pop up so you can drag the icons 
into desired places on the screen and adjust their  dimension as desired: 
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Notice the colours around the silos and the name field under the cage icons.  The colours show to 
which feeding system they belong to.  Grey for Vaki01 and blue for Vaki02. 
 
The dashboard layout can be modified at any time: Configuration->Dashboard layout 
 

Make cages ready for use 

Notice above that when you have just created the cages, that they are grey and it might be this red 
warning ‘x’ in its lower right corner.  The grey colour tell us that the setup isn’t  finish and the red 
warning also gives a hint about something. 

 
When creating the cages for Vaki02, we did not automatically connect it to the pipes, hence the red 
warning.  Hover the mouse over cage and the >>Warning<< to bring up the message. 
 
To make the cages ready, you need to: 

 Connect cage to a silo (the silo tab) 

 Activete “Auto update” 

 Select SGR table to be used (which of course implies that the table must be created or 
imported first) 

 Select a feeding profile (which of course implies that one must be created first) (see profile 
tab) 

 Create a population into the cage and enter its average fish weight (or move it from another 
cage)  

 Press <Calculate feeding> to get the feeding amount pr/day now (else it will just be 
calculated automatically by the end of the day ) 
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To access all this you press the <Edit> button which shows up when mouse is hovered over the cage 
icon: 

 
 
See also the population section: Populations, edit & setup, pg.7 
 
 
 
 
 
 
 
 

 


